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Էլեկտրոնային  Ենթակառուցվածքների  

Ներդրման Գրասենյակ ՓԲԸ  

 

Էլեկտրոնային Ստորագրության  ARX  CoSign ծրագրի 

 Տեղադրումը  և Կիրառումը 

Տարբերակ 3.7 
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1.  ARX Cosign ծրագրի տեխնիկական պահանջները և տեղադրումը 

 

            ARX CoSign ծրագիրն աշխատում է հետևյալ օպերացիոն համակարգերի և  ծրագրերի հետ.  

Windows Vista, Windows 7, Windows 8, Windows 10 

MS Office 2003 / 2007 / 2010 / 2013 / 2016 

Adobe Acrobat, Adobe Reader, Adobe Acrobat Reader DC 

ARX CoSign ծրագրի աշխատանքն ապահովելու համար անհրաժեշտ է ինտերնետ կապ և 443 պորտի հասանելիություն:  

 ARX CoSign ծրագրի տեղադրման համար անհրաժեշտ է միանալ ekeng.am->Թվային ստորագրություն->Անհրաժեշտ 

ծրագրեր  

 Սեղմելով  ARX CoSign հղման վրա ներբեռնվում է թղթապանակը, որը բացելիս անհրաժեշտ է սեղմել  Setup.exe 

բաղադրիչը և տեղադրել ծրագիրը: 

 

Ծրագիրը տեղադրելու համար հարկավոր է անտեսել ARX CoSign Admin բաղադրիչը, քանի որ ծրագրի այս փաթեթը 

չի պարունակում ծրագրի ադմինիստրատիվ կոմպոնենտը: Մյուս բաղադրիչները կնշվեն կապույտ “√” նշանով: 

 ARX CoSign Client 

 Microsoft Office 

 ARX OmniSign Printer (ցանկալի է)   

 

 

 

CoSign ծրագրի տեղադրման բաղադրիչը 
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 Ծրագրի տեղադրման ժամանակ ARX OmniSign Printer-ի հետ առաջացած խնդրի դեպքում  (տես՝ նկար), 

 

 

կարող եք անտեսել այս հաղորդագրությունը, սեղմել OK և ավարտել ծրագրի տեղադրումը Exit կոճակի միջոցով: 

Պատճառը  Cosign ծրագրի  և տվյալ համակարգչի  օպերացիոն  համակարգի անհամատեղելիությունն է: 

  

ARX OmniSign Printer-ի ոչ հաջող տեղադրումը խոչընդոտ չի հանդիսանում Էլեկտրոնային ստորագրության ծրագրի 

համար: ARX OmniSign Printer-ը իրենից ներկայացնում է թվային ստորագրության վիրտուալ տպիչ, որի միջոցով 

ցանկացած .doc, .xls, .txt, .jpg ֆայլ վերածվում է .pdf փաստաթղթի և ստորագրվում: 

 

 

2. ARX Cosign ծրագրի կոնֆիգուրացիան 

 

Ծրագիրը տեղադրելուց հետո բացել էլեկտրոնային ստորագրության ծրագիրը Start –> Programs –> ARX CoSign –> CoSign 

Control Panel (տես` նկարը):  
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Ծրագիրը նորմալ աշխատում է 6 պատկերակի (icons) դեպքում (տես`նկարը) 

 

  

 3 պատկերակի պարագայում  ծրագրի կապը սերվերի հետ չի հաստատվել: 

Խնդրի հիմնական պատճառներն են՝ 

1. Ինտերնետ կապի բացակայությունը                                                                                                                                                           

2. 443 SSL պորտի անհասանելիությունը, proxy server-ի առկայությունը 

3. CoSign Server -ի հետ կապի բացակայությունը    

 

Առաջացած խնդրի դեպքում նախ անհրաժեշտ է ստուգել ինտերնետի առկայությունը կամ 443 SSL պորտի 

հասանելիությունը (proxy server-ի կամ Firewall-ի դեպքում): Proxy server-ի դեպքում պետք է ընտրել «Enable automatic 

ssl detection» պարամետրը Cosign Control Panel ->User->Client Configuration մասում: 

 

Ինչ վերաբերում է  CoSign Server-ի հետ կապված խնդիրներին, ապա  այս դեպքում անհրաժեշտ է Cosign Control Panel 

-> Client Configuration-> Client -> Appliances-> Appliances list հատվածում սեղմել Add կոճակը և  Cosign Appliance DNS 

name դաշտում ավելացնել  ca.gov.am -> OK 
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Այնուհետև կրկին սեղմել Add կոճակը և  Cosign Appliance DNS name դաշտում գրել ca1.gov.am->OK 

 

 

 

Պահպանելու համար անհրաժեշտ է սեղմել File-> Apply (Save to Registry) 
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3. ARX CoSign Control Panel-ի պատկերակների բացատրությունը 

 

ARX CoSign Control Panel–ը նախատեսված է Էլեկտրոնային ստորագրության նախնական պարամետրերը ընտրելու,  

կարգավորելու, ստորագրության գրաֆիկական տեսքը և գաղտնաբառը փոխելու համար: 

 

 Client Configuration պատկերակի օգնությամբ կարգավորվում են ծրագրի պարամետրերը:   

 

 

 

 

 Graphical Signatures պատկերակը նախատեսված է ստորագրության գրաֆիկական տեսքը փոխելու համար:  

 

 

 

1. Ստորագրության գրաֆիկական պատկեր ավելացնելու համար նախապես պետք է ստեղծել ստորագրության 

նկար, մուտք գործել CoSign Control Panel -> Graphical signatures, այնուհետև սեղմել Sign to manage your signatures. 
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2. Մուտքագրել Օգտանուն և գաղտնաբառ 

 

3. Սեղմել   + New Signature 

 

 

 

 

 

 

     4․Նշել Image -> Upload, ընտրել նկարը և սեղմել Save. 

 

 

 Change User Password պատկերակը նախատեսված է գաղտնաբառի փոփոխման համար:  

Այստեղ մուտքագրվում է օգտագործողի անունը, հին գաղտնաբառը և  կրկնակի անգամ` նոր գաղտնաբառը:  

Նոր գաղտնաբառի հաստատումից հետո հին գաղտնաբառն այլևս չի գործում: 

 

 OmniSign Settings պատկերակը նախատեսված է Omnisign ծրագրի պարամետրերը տեղադրելու համար: 

 

 

 Digital Signature appearance բաժնում ընտրել ստորագրության` Ձեր նախընտրած տեսքը: 

 

 Digital signature post action բաժնում ընտրել ստորագրությունից հետո ծրագրի հետագա գործընթացը: Նշել 

Leave OmniSign open բաղադրիչը, որը թույլ կտա փաստաթուղթը  ստորագրությունից հետո պահպանել բաց 

վիճակում: 

 

 Signature Size and Position  բաժնում ընտրել  ստորագրության նախնական դիրքը և չափը: 
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4. Էլեկտրոնային ստորագրության կիրառումը pdf փաստաթղթերում 

4.1.  .pdf ֆայլերի ստորագրումը OmniSign - ի միջոցով: 

 

1. .pdf ֆայլերը կարելի է ստորագրել OmniSign  ծրագրի միջոցով, մկնիկի աջ ստեղնով նշել փակ ֆայլի վրա և բացված 

մենյուից ընտրել Sign with Omnisign կամ Cosign:  

 

 

2. Բացված.pdf ֆայլում ընտրել Sign կոճակը  

 

 

3. Այնուհետև անհրաժեշտ է մկնիկի ձախ սեղմակով նշել ստորագրության տեղը և բացված պատուհանում գրել 

օգտանուն և գաղտնաբառը։ 
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4.2.  Էլ. Ստորագրության կիրառումը Էլեկտրոնային հաշվետվություններում 

   

Մուտք գործելով էլեկտրոնային հաշվետվությունների համակարգ` (մուտքագրել հարկային մարմնի կողմից տրված 

օգտվողի անունը, ձեռնարկության ՀՎՀՀ-ն և գաղտնաբառը)։ Հաշվետվությունը լրացնելուց հետո անհրաժեշտ է 

գրանցել  ու ամփոփել «Լրացված հաշվետվություններ» ենթաբաժնում:  

Սեղմել «Լրացված հաշվետվություններ» բաժինը և մկնիկի սլաքը պահել հաշվետվության  նկարի վրա. 

 

1. Հաշվետվությունը ստորագրելու համար հարկավոր է այն նախապես պահպանել համակարգչում։ Մկնիկի աջ 

ստեղնով նշել հաշվետվության վրա և բացված մենյուից ընտրել Sign with Omnisign (Cosign)  

 

2. Բացված .pdf ֆայլում ընտրել Sign կոճակը 

 

3. Մկնիկի ձախ սեղմակով նշել ստորագրության տեղը և բացված պատուհանում գրել օգտանունը և 

գաղտնաբառը։ 
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4. Հաշվետվությունը ստորագրելուց հետո  բացել այն և ստուգել դրված ստորագրությունը: Տես՝ նկարը: 

 

 

 

4.3.  Ստորագրված  հաշվետվության  հետ  բեռնումը  համակարգ  

 

Հաշվետվության դիմաց` «Գործիքներ» սյունակում, սեղմել  կոճակը, այնուհետև, բացված պատուհանում` «Browse» 

կոճակը և  ընտրել արդեն ստորագրված ու պահպանված հաշվետվությունը: 

 

Բեռնվող հաշվետվության դիմաց` ստորագրությունների ցուցակում,  նշանի փոխարեն պետք է 

ցուցադրվի   նշանը, իսկ  «Հանձնել ՊԵԿ» նշանը պետք է ակտիվանա։   

http://92.43.141.248/pages/submittedForms.jsf?pId=2
http://92.43.141.248/pages/submittedForms.jsf
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4.4. Էլեկտրոնային ստորագրության կիրառումը MS Office ծրագրային փաթեթում 

 

MS Office  

 

MS Office փաստաթղթերում էլեկտրոնային ստորագրություն կիրառելու համար անհրաժեշտ է Word-ի 

փաստաթուղթը պահպանել (Save): Մկնիկի կուրսորը դնել փաստաթղթի այն հատվածում, որտեղ պետք է ստորագրել 

և ընտրել Add-Ins -> Sign with Cosign հրամանը:   

 

 

Բացված պատուհանում մուտքագրել օգտվողի անունը և գաղտնաբառը և սեղմել OK 

 

 

 

Ստորագրությունը կարող է ունենալ հետևյալ տեսքը`     
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5. Հաճախ տրվող հարցեր 

5.1. Ինչու՞ եմ ստանում Failed to select a certificate հաղորդագրությունը 

 

ca.gov.am սերվերի հետ կապված խնդիրների դեպքում անհրաժեշտ է Cosign Control Panel -> Client Configuration-> Client 

-> Appliances-> Appliances list հատվածում սեղմել Add կոճակը և  Cosign Appliance DNS name դաշտում ավելացնել  

ca.gov.am  և  ca1.gov.am հասցեները:  

 

 

 

5.2. Ինչու՞ է երևում երեք պատկերակ CoSign Control Panel-ում։ 

 

ARX CoSign Control Panel-ում 3 պատկերակի առկայության դեպքում, ծրագրի կապը ca.gov.am և ca1.gov.am հասցեում 

գտնվող CoSign Server -ի հետ չի հաստատվել: Անհրաժեշտ է ստուգել ինտերնետի առկայությունը կամ 443 SSL պորտի 

հասանելիությունը (proxy server-ի կամ Firewall-ի դեպքում): Proxy server-ի դեպքում պետք է ընտրել «Enable automatic 

ssl detection» պարամետրը Cosign Control Panel ->User->Client Configuration մասում: 

 

 

5.3. Ինչու՞ է հաճախակի հայտնվում մուտքագրման (login) պատուհանը։ 

 

Տվյալ պատուհանը ժամանակավորապես հեռացնելու համար Cosign Control Panel –ում անհրաժեշտ է կատարել 

հետևյալ փոփոխությունը. ընտրել Cosign Control Panel -> Client Configuration -> Client ->Login Dialog->Set login dialog 

parameters դաշտը և նշելDisable login dialog տարբերակը, այնուհետև սեղմել File -> Apply(Save to Registry)` 

փոփոխությունները պահպանելու համար 

 

http://www.ekeng.am/wp-content/uploads/disable-login-dialog.jpg
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5.4. Ինչու՞ եմ ստանում “Failed to select a certificate, Bad Username or password” զգուշացումը։ 

 

Մինչև 5 անգամ սխալ գաղտնաբառ մուտքագրելու դեպքում, գաղտնաբառն ավտոմատ արգելափակվում է և 

հայտվում է հետևյալ հաղորդագրությունը. 

  

Գաղտնաբառն ակտիվացնելու համար անհրաժեշտ է զանգահարել 374  60 464 504 հեռախոսահամարով կամ նամակ 

հղել support@ekeng.am  էլ. հասցեին: 

 

5.5. Ինչու՞ է էլ. ստորագրության ամսաթիվը (ժամը) տարբերվում իմ համակարգչի ամսաթվից։ 

 

Էլ. ստորագրության ամսաթիվը և ժամը ավտոմատ կերպով օգտագործում է սերվերի տվյալները: Եթե Ձեր 

ստորագրության ամսաթիվը սխալ է և չի համապատասխանում ստորագրության տեղադրման ամսաթվին կամ 

ժամին, ապա զանգահարեք հաճախորդների սպասարկման կենտրոն + 374 60 464 504 հեռախոսահամարով՝ 

ճշտումներ կատարելու նպատակով: 

 

5.6. Ինչու՞ է բացակայում Sign with OmniSign կամ Sign with Cosign հրամանը .PDF ֆայլի աջ ենթամենյուից։ 

Տվյալ հրամանը կարող է բացակայել, եթե 

  

1.  Adobe Reader ծրագիրը տեղադրվել է  ARX Cosign ծրագրի տեղադրումից հետո 

2.  Եթե Adobe Reader ծրագիրը թարմացվել է(update)  

 

Նման պարագայում ARX Cosign Client ծրագիրն անհրաժեշտ է վերատեղադրել` առանց այն նախապես հեռացնելու: 

 

5.7. Ինչպե՞ս կիրառել նույն համակարգչում երկու և ավելի ստորագրություն։ 

Միևնույն համակարգչում 2 տարբեր ստորագրություններ կիրառելու դեպքում, անհրաժեշտ է առաջին օգտվողի 

անվամբ ստորագրելուց հետո, սեղմել Log off կոճակը Start-> Programs-> ARX CoSign -> Cosign Control Panel –ում, 

այնուհետև ստորագրել նույն փաստաթուղթը` օգտագործելով այլ օգտվողի անուն և գաղտնաբառ: 

5.8. Ինչպե՞ս ստուգել և վավերացնել Cosign օգտագործողի էլ. ստորագրությունը MS Office ֆայլերում։ 

 

Cosign օգտագործողի ստորագրությունը վավերացնելու համար` Մկնիկի աջ սեղմակով սեղմելով էլ. Ստորագրության 

վրա ընտրել “Validate” տարբերակը` ստանալով «√» վավերացման նշանը: Ստորագրող անձի տվյալները ստուգելու 

համար` ստորագրության վրա մկնիկի աջ ենթամենյուից ընտրել “Details” տարբերակը, որը հնարավորություն կտա 

տեսնել ստորագրողի տվյալները ներառող էլ. հավաստագիրը:  

 

Էլ. հավաստագրի մանրամասներին կարելի է ծանոթանալ ներկայացված պատուհանի View Certificate կոճակի 

օգնությամբ: Այն ներկայացնում է հավաստագրի թողարկման ընդհանուր նկարագրությունը և վավերականության 

ժամկետի մանրամասները:  

mailto:support@ekeng.am%20%20%20էլ.%20հասցեին
http://www.ekeng.am/wp-content/uploads/badusername.jpg
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5.9. Ինչպե՞ս ստուգել  .PDF փաստաթղթի ստորագրության վավերացումը և փոփոխությունը։ 

 

Մկնիկի աջ սեղմակով սեղմելով էլ. ստորագրության վրա՝ ընտրել Validate Signature ենթամենյուն: Բացված 

պատուհանից ընտրել Signature Properties կոճակը: Բացվում է պատուհանը` ստորագրության մանրամասն 

տեղեկությամբ: 

 

5.10. Ինչպե՞ս ներմուծել հավաստագիրը Adobe-ի վստահված հավաստագրերի ցուցակ։ 

 

Հավաստագիրը Adobe ծրագրի վստահված հավաստագրերի ցուցակում ներառելու համար անհրաժեշտ է մկնիկի աջ 

կոճակով սեղմել ստորագրության վրա, ընտրել  Validate Signature -> Signature Properties -> Show Certificate -> Trust - 

Add to trusted Identities ->OK:               

Բացված Import Contact Settings պատուհանում նշել  Use this certificate as a trusted root  և  Certified documents նշման 

ակտիվ դաշտերը (checkbox):   
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